When it comes to MIDI, there’s no denying it’s a powerful music-creation tool. In fact, entire courses have been built around its understanding and application. That being said, becoming a strong MIDI user isn’t essential to many Pro Tools users (for example, traditional studio engineers and post-production editors). Chapter 7, “Using MIDI,” dealt with the basic MIDI skills that will help even a non-MIDI-phile work with musicians who come into the studio; this appendix goes a bit deeper.

In this appendix, you’ll learn how to:

- Use MIDI Beat Clock.
- Use the MIDI Operations windows.
- Use the Pro Tools MIDI timeline.
- Use the MIDI Editor and Score Editor windows.

**TUTORIAL SESSION**

Don’t worry if you don’t have any MIDI data to work with. A practice session has been included with the downloadable materials for this book, named “Appendix A Exercise Session.” For information on downloading this book’s exercise material, please refer to the “Setting Up Your Session” section of the introduction.
Using MIDI Beat Clock

MIDI Beat Clock is a continuous stream of tempo-based pulses (going faster with higher tempi, slower with lower tempi) that enables multiple tempo-based devices to stay in sync. For example, if you have a synthesizer that includes an arpeggiator, you’ll want that device to not only play the notes that are sent to it, but also to arpeggiate them in time with the Pro Tools session. That’s where MIDI Beat Clock comes in. Beat Clock is also commonly used with external drum machines, ensuring that drum patterns not only start and stop at the right time, but play at the proper tempo as well.

These days, most virtual instruments that can follow MIDI Beat Clock automatically configure themselves to do so. Manual configuration is generally reserved for external hardware devices. Here’s how to set them up:

1. Click on the Setup menu.
2. Choose the MIDI menu item. A submenu will appear.
3. Choose the MIDI Beat Clock menu item. The MIDI Beat Clock dialog box will appear.
4. Click on the Enable MIDI Beat Clock For checkbox to activate MIDI Beat Clock for the selected ports. When enabled, the box will be checked.
5. Select the specific ports through which you wish to send MIDI Beat Clock. Notice that the ports are named according to the devices you set up in the MIDI Studio Setup window. Selected devices will be indicated by a checkmark.
6 Frequently, MIDI can include a significant amount of latency (a fact of which experienced MIDI users are all too aware). To compensate for that latency, type a value in the Offset (Samples) field on a port-by-port basis. This value can be either positive (offsetting the MIDI Beat Clock later) or negative (offsetting the MIDI Beat Clock earlier, to compensate for MIDI latency).

7 Click on the OK button. The MIDI Beat Clock dialog box will close, and you’re all set!

**HEY, I’M NOT SEEING MY VIRTUAL SYNTH!**

It’s not uncommon for virtual instruments to automatically enable themselves to receive MIDI Beat Clock as soon as they’re launched. These devices will not be shown in the MIDI Beat Clock dialog box.

The Event Operations Menu

In addition to editing with tools, you can also transform your MIDI from the Event Operations menu. Most of the features in this menu are commonly found in most MIDI sequencers and fall into the category of basic operations, but it is useful to know the layout of the menu and windows involved.

Here’s how you start the process:

1 Select the group of notes that you want to process.

2 Click on the Event menu.

3 Choose Event Operations. A submenu will appear.

4 Choose the process you want to apply to the selection, and the appropriate window will open.
Grid/Groove Quantize
At its most basic level, Quantize is a MIDI function that aligns the timing of MIDI notes to a grid. It’s commonly used to fix timing errors or to create mathematically “perfect” timing when the style of music calls for it. You’ll find the Quantize function near the top of the Event Operations menu.

The What to Quantize section enables you to choose individually which parts of your notes will be adjusted. For example, if you want to have the beginning of your notes snap to the grid line but leave the end of the notes unchanged, check only the Note On checkbox.
The Options section will enable you to tweak your quantization and to choose how notes will be affected. Raising the Swing value will progressively add a triplet-style feel. The Include Within and Exclude Within parameters will enable you to choose how much of your data will be affected. (Including 100 percent and excluding 0 percent will ensure that all your MIDI data is quantized. This is the default if these checkboxes are left unchecked.) Strength will enable you to choose how much to change your notes’ original timing. For example, if your strength is set to 100 percent, your notes will be moved all the way to the nearest grid line, whereas at 50 percent they’ll be moved only halfway to the nearest grid.

Beyond basic grid quantizing, there’s Groove Quantize. When you use Groove Quantize, you won’t be moving your notes’ timing to your session’s grid lines per se, but rather to a set of complex location points designed to emulate a certain musical feel. Fortunately, the process of groove quantizing is almost identical to regular grid quantizing. Here’s how it works:
Change Velocity

The Event Operations/Change Velocity dialog box sports options with which you can manipulate MIDI velocity (that is, how fast a key is pressed). As with Quantize (and all other event operations), Change Velocity acts on the current selection.

**ADVICE ON RANDOMIZING**

Users sometimes apply the Randomize feature to a MIDI drum track in the hopes that it will “humanize” the track, but this often has a negative effect on the groove. (Remember, a live drummer, though mathematically imperfect, is not playing in a random fashion!) However, when used sparingly, the Randomize feature works very well with tracks that would normally be played by multiple musicians (string sections, brass sections, and so on), taking the edge off the mechanical accuracy sometimes associated with MIDI.

**IF YOU’RE USING THE EXERCISE MATERIALS...**

If you’re working with the exercise session, quantize the drums to a 1/16 note grid.
The Set All To option enables you to assign a single velocity value to all selected notes. You can directly increase or decrease the velocity values by a set amount by using the Add or Subtract option.

You can scale, or proportionally change, the velocity of a set of notes using the Scale By option. You can use the Change Smoothly option to gradually change the velocity from the beginning of the selection to the end, resulting in an increase or decrease in intensity. By using the Change Smoothly by Percentage feature, you can even specify an exponential or logarithmic curve for the change.
MIDI NOTE COLOR SHOWS VELOCITY

MIDI velocity is a very powerful MIDI parameter, and the ability to use it well can breathe life into your MIDI projects. In Pro Tools, you can quickly get a sense of the velocity of individual notes using the MIDI Note Color Shows Velocity feature.

To activate this feature, just click on the MIDI Note Color Shows Velocity checkbox, found in the upper-right corner of the Display page of the Pro Tools Preferences dialog box. When active, the checkbox will be marked with a check, as shown here.

With the MIDI Note Color Shows Velocity preference checked, your MIDI notes will be lighter in color at lower velocities and darker at the higher velocities.

Change Duration

The Change Duration dialog box is similar to the Change Velocity dialog box, but in this case, the parameters affect the length of the selected notes.

- The first option button will enable you to set all durations to a single value or to add or subtract a fixed value. You can choose the desired behavior from the corresponding menu.
- The Legato option will enable you to extend the duration of the selected notes. The dropdown menu to the right of the option button will enable you to specify either an overlap or a gap between notes.
Transpose

Transpose, a common MIDI operation, changes the note number of MIDI note data, effectively changing the pitch of your music. The options for Pro Tools' Transpose function are simple and straightforward:

- The third option button will enable you to remove overlaps, which can be problematic in some circumstances, and leave a specified gap between notes.
- The Transform Sustain Pedal to Duration option button will detect pedal data and apply it to the durations of the affected notes.
- The Change Continuously option will enable durations to gradually change over time, similar to the Change Continuously feature in the Change Velocity window.

You can adjust pitch by octaves and/or semitones (half steps).
You can transpose based on relative pitches, selecting an original pitch and a destination pitch to apply transposition to your selected notes.
You can change all pitches to a single pitch, regardless of their original pitch (particularly useful when you’re working with drum tracks).
You can move notes up or down by scale steps, based on the active key in the Key Signature ruler (discussed later in this appendix).
Select/Split Notes

After you've selected notes using the Selector or Grabber tool, you can further narrow your selection by setting specific criteria in the Event Operations/Select/Split Notes window. Additionally, the split notes functionality in this window enables you pull notes from that selection and move them in a number of different ways.

### 1. Whether you ultimately want to select or split the notes, you'll start by defining your selection based on some sort of pitch value. You can select All Notes, set a range (using the Notes Between function), or pick out notes starting from the top or bottom of each chord in the selected area. If you're using the Exercise session, choose All Notes.

### 2. You can refine your selection based on velocity, duration, or even position (measured in beats/ticks) within the selected bars.

### 3a. If you want to process your selected notes further, choose the Select Notes option button, click on the Apply button, and move on to your next step.

**OR**

### 3b. If your goal is to split the notes, choose the Split Notes option button. If you’re using the Exercise session, choose this option. You have a number of options in this case:

**BE CAREFUL WITH YOUR DRUM TRACKS!**

Before you change the pitch of an entire section of a song, you might want to exclude your drum tracks from that transposition. Transposing drum-kit patches tends to radically change the instrument assignments!

**IF YOU’RE USING THE EXERCISE MATERIALS...**

If you’re working with the Exercise session, your task will be to split out the Drums track’s sounds (remember that the Drums track comprises an entire drum kit) into a number of tracks, each with its own sound (in other words, a Kick track, Snare track, and so on).
Clicking on the menu in the lower-left corner of the window will give you the option of choosing whether the notes will be cut from the selected area or copied (leaving the original notes intact). If you’re using the Exercise session, choose to cut the selected notes.

The menu in the lower-right corner of the window will enable you to choose your split notes’ destination. You can send them to the clipboard (for pasting later), to a new track (all the split notes will go to that track), or to a new track per pitch (for example, if you split up a four-note chord, you would create four separate tracks, each with one pitch). For the purposes of the Exercise session, choose a new track per pitch.

**A MIDI DRUM WORKFLOW**

Most often, a MIDI drum kit will be recorded to a single MIDI or Instrument track, with all the drum set’s component drums together in single clips. This is great from a recording perspective, but sometimes having all the drums together can make editing a bit difficult. Using the Select/Split Notes dialog box can really save the day in situations like these. Just select your entire drum track, make sure the All Notes option button is chosen in the Pitch Criteria section, and then split your notes. If you choose to cut the notes to a new track per pitch, you’ll see all the notes in the original track disappear, and each individual pitch (which in the world of MIDI drums means individual drums) appear on its own track. From there, you can get down and dirty with your drum editing!

One detail of which to take special note: When you split notes to separate tracks, you may still need to fix the MIDI output assignments of the newly created tracks. In the case of the Exercise session, you can easily fix the routing problems by copying the Xpand2 plug-in from the original track to the new tracks. Just hold down the Option (Mac) key or Alt (PC) key and drag the plug-in to each new track.

**Input Quantize**

The Input Quantize feature works just like the basic Quantize function with one important difference. Whereas Quantize is applied to MIDI data manually after it has been recorded, Input Quantize applies the change as soon as a record pass is finished. This feature is particularly nifty for technically challenged people like me; it fixes my timing automatically!
More MIDI Power

Select the Enable Input Quantize checkbox to turn on the Input Quantize feature. Don’t forget: Input Quantize will stay enabled until you manually turn it off!

GETTING THE MOST OUT OF INPUT QUANTIZE
Just like regular Quantize, Input Quantize can align notes to the grid or to a groove template. You can choose the resolution and type of quantization from the Quantize Grid menu.

Step Input
From its earliest days, MIDI has been able to lend a helping hand to pedagogically challenged keyboardists (like yours truly), and Step Input is probably the ultimate expression of this. Don’t worry about slowing down the tempo so you can play a difficult passage slowly; Step Input enables you to play completely out of time. Just set a starting point and a note value, and off you go! You can play as fast or slow as you want, and notes will be sequentially created. Here’s how:
1 Set the session’s timeline insertion at the point at which you want to begin creating new notes.

2 Click on the Enable checkbox to activate Step Input.

3 Click on the Destination Track drop-down list and choose the track to which you’ll be writing. (Clicking on the drop-down list reveals a list of MIDI and instrument tracks in your session.)

4 Choose the desired note value by clicking on the appropriate Step Increment button. The Note Length slider will enable you to change the duration of the notes you create. In this example, I’ve selected 1/8 notes as my step increment, and the 100-percent note duration means that each new note will be a full-length 1/8 note.

* You have a choice when it comes to note velocities: You can choose Use Input Velocity (each new note will be created at the velocity at which it was played) or Set Velocity To (which will assign a fixed velocity level to each note created).
Click on the Enable Numeric Keypad Shortcuts checkbox to enable your keyboard’s numeric keypad to change the step-increment settings. (Number 1 will change the value to a whole note, 2 will change the value to a half note, and so on.)

Made a mistake? The Undo Step button will clear your last note entry.

Clicking on the Next Step button will skip the current step and move you to the next increment, leaving a silent step between notes (a rest).

Finally, clicking on the Redo Step button will redo the most recently entered step, if it has been undone.

**Restore Performance**

Pro Tools’ Restore Performance feature is a simple enough operation, but it’s invaluable when you need it. Think of Restore Performance as an improved version of the Undo operation. Consider this: When you save and close your session, the Pro Tools undo history is cleared, which prohibits you from undoing things such as audio clip edits and so on the next time the session is opened. What makes Restore Performance so special is that, for MIDI data, it extends beyond the last time you saved your session and the traditional levels of undo!

Once you’ve selected the MIDI notes you want to affect, you can selectively restore specific aspects of your MIDI data, such as timing, duration, velocity, or pitch—it’s up to you what to recover and what to keep current. When you restore any of these aspects, your MIDI data will revert to its original state (when it was recorded) or to the last time the performance was flattened (which I’ll talk about next), whichever happened most recently.
Flatten Performance
Suppose you’ve perfected your MIDI data through meticulous editing, and you want to make sure you can easily recover this ideal state. That’s the perfect time to flatten the data. When you choose Flatten Performance, you “print” your MIDI data to your session and remove the option to undo any previous edits that you’ve performed. If, in the future, you choose to restore the performance, it will revert to this new flattened state.

As with the Restore Performance option, you can selectively flatten specific aspects of your MIDI data. When you flatten your performance, you will effectively set a new restore point for any of the attribute checkboxes you’ve checked that you can recall at will using the Restore Performance feature.

Working with the MIDI Timeline
In Chapter 7, you learned the basic operation of changing tempo—probably the most common way in which a Pro Tools user can alter the MIDI tempo map of a session. Here are some additional tools that you can use to change your MIDI timeline in more complex ways.

Changing Meter and Renumbering Bars
In addition to changing your session’s tempo, you can change the meter upon which your measures (bars) are based and even shift the numbering of bars.

1 Click on the Event menu, choose the Time Operations menu item, and choose Change Meter to reveal the Time Operations/Change Meter window. Here are some key features:
You can type the desired meter in the New Meter section.

You can change the resolution of your click by clicking on the Click display and then choosing the desired resolution from the drop-down menu that appears. For example, if you change your meter to 6/8, you might want to set your click up as 1/8 notes or dotted 1/4 notes.

You can type the starting measure of your meter change in the Starting at Bar field.

Clicking on the Apply Change button will enable you to choose the duration of your meter change from a drop-down menu. Options include To Session End, To Selected Range, or Until Next Bar.

Renumbering bars is even easier....

1. Click on the Event menu.

2. Choose Renumber Bars. The Renumber Bars dialog box will open.

The Renumber Bars dialog box is fairly self-explanatory—just enter the changes you want to make and click on the Renumber button. This won’t change the way your session sounds, but it will affect the numbering of your song’s measures.
Changing the Song Start

Suppose you’ve written a song, only to find that you need to place some audio (or MIDI) before bar 1. You could renumber the measures (which I just discussed), or you can take advantage of Pro Tools’ Move Song Start feature. As with many aspects of Pro Tools, there are a number of ways to get the job done.

1. Click on the Event menu.
3. Choose Move Song Start. The Time Operations/Move Song Start dialog box will open.
The bottom area will enable you to choose what aspects of your session are to be affected by the movement of the song start:

- Selecting the top option button—Song Start Only—will only change your session’s Tempo ruler and will leave all clips where they are.
- The bottom option button will move the song start; tempo, key, and chord rulers; and all tick-based tracks and markers. (By default, MIDI and Instrument track clips are tick-based.) You can also affect sample-based markers and clips on sample-based tracks (by default, Audio tracks are sample-based) by clicking on the corresponding menu button. In this example, no sample-based markers or tracks will be changed. For more information on the distinction between tick-based and sample-based, refer to Chapter 6, “...And More Editing.”

Here’s perhaps an easier way:

1. Click and drag the Song Start marker on your Tempo ruler. (It will be a diamond shape, slightly larger than the other tempo objects and colored red.) By default, dragging the Song Start marker will move everything but sample-based tracks and markers.

**Cutting and Inserting Time**

The nonlinear nature of the modern DAW offers an undeniable advantage, but from time to time, you may long for the simplicity of the old tape-based cut-and-splice method. Pro Tools has just what the doctor ordered, in the form of the Cut Time and Insert Time operations.
1. Although not strictly necessary, you can select the section on the timeline that you want to cut or insert to make the process easier.

2. Click on the Event menu.


4. Choose Insert Time (shown here) or Cut Time. The appropriate Time Operations window will open.

Although there are no specific steps associated with this section, go to Memory Location #2—Editing MIDI.
Whether you choose to insert or cut time, you’ll notice that the window bears great similarity to the Move Song Start window. The main difference is that instead of shifting the timeline, you’re either adding to it or taking away from it. If you’ve made a selection, you’ll find these values reflected in the Start, End, and Length fields.

More MIDI Tips

In the chapters of the book, you learned the basics of working with MIDI. Now let’s take a look at some alternative ways to get the job done, and some of Pro Tools’ more powerful MIDI features!

Viewing and Editing Non-Note Data

In Chapter 6, you learned how to edit non-note data such as volume, velocity, and pan with the MIDI Event list, but in most cases, it’s more easily accomplished on the track itself. The process is a straightforward one, but you have to know how to view it before you can work with it.

1. In this example, you’re looking at (and are thus able to edit) clips, indicated by the label on the Track View button. Click on the Track View button. A menu of other view options will appear.

2. Select the kind of MIDI data with which you want to work. The track to the right will change to show the kind of data you selected.
In this image, I’ve chosen to change my track’s view to show velocity data. I can use the same tools I’ve used for the note data (such as the Grabber, Trim, Selector, and Pencil tools, and so on) to change these values.

I’ve talked about track lanes (in Chapter 5, “Editing”), but now you’ll use them in a different way. With track lanes, not only can you view non-note MIDI data, but you can also view multiple types of non-note data simultaneously!

1. **Click** on the **Show/Hide Automation Lanes button** (the small triangle in the lower-left corner of the track row). An indented track lane will appear below the track’s main playlist area.

2. **Click** on the automation lane’s **Lane View button** to choose the desired view, just as you did with the Track View button earlier in this appendix.

3. If you want to see more track lanes, **click** on the **Add Automation Lane button** (the small plus [+] button on the left margin of the lane). If you want to hide a lane, **click** the **Remove This Automation Lane button** (the small minus [−] button).

**MIDI Real-Time Properties**

The MIDI Real-Time Properties feature in Pro Tools has, over time, become one of my favorite gems in this DAW. What sets this feature apart from the MIDI processes I’ve discussed is that these real-time properties, which are perhaps better described as real-time processes, alter the data only as it’s being played back. They don’t alter the recorded data in any permanent way. This opens up a nondestructive and non-linear creative process.
Although there are a couple of different ways to use the MIDI Real-Time Properties feature, the most straightforward method is to use the Real-Time Properties Edit window column, so let’s begin there.

1 If you’re not currently seeing the Real-Time Properties column, you’ll have to reveal it in your Edit window. Click on the View menu and choose Edit Window Views. A submenu will appear.

2 This submenu is a list of columns available in your Edit window. (Shown columns are indicated by a checkmark.) Choose the Real-Time Properties menu item, and the Real-Time Properties column will appear.

- Here’s another way to show the Real-Time Properties column: Click on the Edit Window View button, located in the upper-left corner of the Edit window’s track area. A list (identical to the Edit Window Views submenu) will appear, allowing you to make sure that the appropriate columns are shown. (Again, shown columns are indicated by a checkmark.)

In the Real-Time Properties column, you’ll notice five buttons, which will enable you to adjust settings for the Quantize (QUA), Duration (DUR), Delay (DLY), Velocity (VEL), and Transpose (TRN) features. In this image, all the buttons are selected to show the complete layout of the column. In actual practice, you can enable or disable each button at will. (Enabled buttons will be colored green.) Note that these buttons only appear on MIDI and Instrument tracks.

- When a button is enabled, you’ll see a set of adjustable parameters displayed to the right of the button. This is essentially a tiny version of the main parameter(s) that you would otherwise have chosen in the Event Operations windows.
For this example, you’ll try changing the timing of the drums track. Click on the QUA button. You’ll immediately see that each clip on your track is marked with a T (for track-based real-time processes) in the upper-right corner, indicating that it is now being quantized in real time.

Let’s have some fun with Groove Quantize. Click on the button immediately to the right of the QUA button. A list will appear.

Here’s where it gets fun. Choose the quantization that you want to try out. For this example, I’ve chosen FeelInjector_8th_shfl from the Feel Injector Templates folder, because it’s a very different feel from the original beat. If you feel that this difference is an improvement, you’re finished. If you don’t like it, no problem; you can choose any other kind of quantization you want, or you can choose not to quantize at all by clicking on the QUA button and turning off the MIDI Real-Time Properties feature. That’s the beauty of this feature—nothing you’ve done is permanent!

**TWEAKING ON THE FLY**

The MIDI Real-Time Properties feature is great not only because it processes your MIDI as it plays, but because you can also change settings and immediately hear the result. In the case of quantization, you can change the feel during playback and listen to how your changes will affect the track and your entire song.

Although the Real-Time Properties Edit window column is the easiest way to access this feature, there is another method—the use of the Real-Time Properties floating window—that will give you extra flexibility. The fundamental difference between the Real-Time Properties column and the Real-Time Properties floating window is this: Changes made in the Real-Time Properties column will apply to an entire track, and any clips that you drag onto that track will reflect these real-
time changes. The floating window, on the other hand, will enable you to modify any selected clips or tracks. Also, individual clips modified via this window will retain these changes, even if they’re moved to another track. Using the Real-Time Properties floating window may be a little more complex than using the Edit window column, but the flexibility that you gain is well worth the effort!

**IF YOU’RE USING THE EXERCISE MATERIALS...**

If you listen to the Drums track, you’ll see that the third clip doesn’t sound quite right. That’s because all the notes are one whole step too low! You’ll use the Real-Time Properties floating window to fix this individual clip.

1. **Select** the clip(s) or track(s) you want to change. If you’re using the Exercise session, choose the third clip on the track.

2. **Click** on the Event menu.

3. **Choose** the MIDI Real-Time Properties menu item. The Real-Time Properties floating window will appear.

4. The first order of business is to choose what selected elements you wish to affect. **Click** on the Apply To button.

5. The Apply To list enables you to choose either the selected track(s) or selected clip(s). In this example, the Drums 3 track is selected, as is the clip Drums 3-02. Because you just want to change the selected clip, make sure the Clip “Drums 3-02” menu item is selected.

As with the Real-Time Properties Edit window column, you have the option of changing settings for Quantize, Duration, Delay, Velocity, and Transpose.

To the right of each button is an area where you can adjust parameters and values as needed.
Click on the appropriate button to affect the desired parameter. If you’re following the tutorial session, you’ll want to change the pitch of the selected clip, so click on the Transpose button. The area to the right of the button will become active.

Enter the desired values in the appropriate fields. If you’re using the tutorial session, the selected clip can be easily fixed by transposing it up by two semitones. (But don’t take my word for it—use your ears!)

Clips that are altered with the MIDI Real-Time Properties Edit Window column are indicated by an T (for track-based real-time processes) in the upper-right corner of the clip.

Individual clips that are altered with the MIDI Real-Time Properties floating window are indicated by an R (for region-based real-time processes) in the upper-right corner of the clip.

Remember that when you’re using the MIDI Real-Time Properties feature (through either the column or the floating window), you’re working nondestructively. You can quickly remove any real-time properties by clicking on the Clear Clip Properties button.

If you want to work destructively, you can apply your changes more permanently by clicking on the Write to Clip button. Your MIDI data will be changed, and the R will disappear from the clip, because it’s no longer being processed in real time.
Key Signatures

Those of you who read traditional Western music notation (the notes, staffs, and other symbols that we commonly associate with written music) know that a key signature is a notational device that tells the reader what tonal structure, or key, the music is in. You’ll typically find a key signature at the beginning of a piece of music, and additional key signatures may appear later in the piece to indicate a harmonic change (commonly referred to as a key change).

Pro Tools includes a Key Signature ruler to help you organize your music and keep track of what key you’re in. In typical Pro Tools fashion, though, the functionality of key signatures goes beyond the basics. Let’s take a quick look.

**IF YOU’RE USING THE EXERCISE MATERIALS...**

For the remainder of this appendix, screenshots will be based on another tutorial session, so if you need to save your work, now’s the time to do so. A version of this session showing the completed form of many of the topics covered so far is included in the Appendix A Exercise Session folder, as a session file named “Appendix A Exercise Session–Finished.”

Although it’s not specifically necessary to see key signatures displayed traditionally, it can be helpful, and the expanded display will enable you to see this notational view. To see an expanded display of the Key Signature ruler, click on the triangle icon to the left of the word “Key.”

By default, the key signature of a Pro Tools session is the key of C major (no sharps or flats). To change that key signature or add a new key signature, click on the Event menu and choose the Add Key Change menu item. The Key Change dialog box will appear.

If the Key Signature ruler is visible, you can also change or create a key signature by clicking on the Add Key Signature button to the right of the word “Key” (indicated by a plus [+] sign). The Key Change dialog box will appear.
You can choose either major or minor key signatures by clicking on the appropriate option button in the Key Change dialog box.

Once you’ve chosen either major or minor keys, you can choose the specific key you want to use. (Just click on the desired key signature.)

In the From field, you’ll be able to choose where your key signature will be placed. The option buttons below this section will let you determine the duration of that key signature. (The default selection is Next Key Signature, which works well in most situations.) Checking the Snap to Bar checkbox will automatically set key changes to begin and end at the beginnings of bars (the most traditional way to use key signatures).

By default, a key signature is simply a visual marker for your convenience, but you can choose to have the key change your session’s pitched tracks by checking the Edit Pitched Tracks checkbox.

HUH?!?

What the heck is a pitched track, you ask? Good question. I’ll get to that in just a second.
If you decide to edit your pitched tracks, you can change their tonality by checking the Transpose checkbox. To the right of the Transpose checkbox are two drop-down menus:

- The first menu will enable you to transpose your notes either up or down in pitch—pretty straightforward stuff.
- The second menu will enable you to transpose either chromatically or diatonically. This can get a little tricky. Chromatic transposition (the simplest form) will merely move your existing notes up or down by a set number of half steps. Diatonic transposition will still move notes up or down, but will also automatically adjust notes to fit the new tonality (major or minor). “Blue” notes and other non-scale tones will retain their relationship to the tonic (the key letter) when transposing diatonically.
- Finally, the Constrain Pitches to Key checkbox will adjust all notes to fit the chosen key.

**IF YOU’RE USING THE EXERCISE MATERIALS...**
Many of you will quickly realize that this song isn’t in C major (the default key signature of Pro Tools), but rather in the key of A minor (which coincidentally also has no flats or sharps). Please change the key signature beginning at the start of bar 1 to A minor, without editing any pitched tracks.

When you’ve made your choices, click on the OK button, and your new key signature will be created. You can create additional key signatures at any other point in your session.

**Editing Pitched Tracks**
There’s a concept closely related to key signatures, and that’s the idea of pitched tracks. In Pro Tools, MIDI and Instrument tracks can either be pitched (in which case the notes are tonal in nature and should therefore follow key changes), which is the default, or unpitched (in which case MIDI notes trigger non-tonal sounds). Drum kits are great examples of unpitched tracks. Here’s how to change a drum track from being pitched to unpitched.

**IF YOU’RE USING THE EXERCISE MATERIALS...**
Just to spice things up a bit, you’ll add a key change to the song at measure 14. Before you do that, though, you’ll have to change the Drums track from pitched to unpitched so that it doesn’t change when the key change is applied.
1 Click on the Playlist button of the desired track (in this example, the Drums track). A menu will appear.

2 By default, all MIDI and Instrument tracks are set to be pitched, indicated by a checkmark next to the word “Pitched.” Just click on the Pitched menu item to remove the checkmark, and you’re done—the track is now unpitched.

3 Now, when you add a key change to your session, you can effectively use the Edit Pitched Tracks feature. With this checkbox checked, the key changes you choose will affect all pitched MIDI and Instrument tracks (bass tracks, piano tracks, and so on) but leave your unpitched tracks (in this example, the drums) untouched.

**IF YOU’RE USING THE EXERCISE MATERIALS...**

Try adding a key change to the key of D minor at measure 14 (after the drum break), making sure to edit your pitched tracks. (Refer to the image of the Key Change dialog box for the correct settings.)

**CHECKING YOUR WORK**

To see the Exercise session with the key change applied, and check out many of this chapter’s steps in their completed form, check out the Appendix A–Key Changes–Finished session.
The MIDI Editor and Score Editor Windows

At the heart of Pro Tools’ music-production power are the MIDI Editor and Score Editor windows. These two editing environments combine powerful MIDI features with the tried-and-true editing tools that have made Pro Tools a leader in the audio-editing world. What does this all mean? Basically this: With the MIDI Editor and Score Editor windows, you’ll be able to apply the editing skills you’ve already learned in a whole new way!

The MIDI Editor

The MIDI Editor is the place to go if you want to get a close look at MIDI and Instrument tracks. There are two ways to access the MIDI Editor: with the docked MIDI Editor (which is part of your Edit window) or through a standalone MIDI Editor window.

The Docked MIDI Editor

The docked MIDI Editor is a component of your Edit window, but one you might not have seen yet. Let’s take a look.

1. Click on the View menu.
2. Choose Other Displays.
3. Choose the MIDI Editor menu item. (A checkmark will appear next to displayed elements.) The docked MIDI Editor will appear at the bottom of the Edit window.
Here’s another way to show the docked MIDI Editor:

1. Click on the Edit Window button (located in the upper-right corner of the Edit window). A pop-up list will appear.

2. Choose MIDI Editor. The docked MIDI Editor will appear at the bottom of the Edit window.

And yet another way!

1. Click on the small, upward-pointing arrow in the bottom corner of the Edit window’s playlist area. (Note that clicking on it can be a little tricky.) The docked MIDI Editor will appear at the bottom of the Edit window.
No matter which method you use to reveal it, the docked MIDI Editor will appear along the bottom of the Edit window. You can adjust the size of the docked MIDI Editor in the Edit window by clicking and dragging its upper boundary. Note that the docked MIDI Editor includes its own version of the Tracks list and edit tools—something you’ll explore in just a bit.

The MIDI Editor Window

Although the docked MIDI Editor works well in combination with the Edit window, the window can get a little crowded—and remember, the bigger your MIDI Editor gets, the smaller the rest of the Edit window gets! For really serious MIDI editing, the MIDI Editor window is often the way to go.

1. **Click on the Window menu.**
2. **Choose MIDI Editor.** The MIDI Editor window will appear.

For those (like yours truly) who use the MIDI Editor window quite frequently, there’s a quicker way to open the window. Simply by double-clicking on a MIDI clip, you can launch the window—if you set up your preferences to do so.

1. **Open the Pro Tools Preferences dialog box (from the Setup menu).**
2. **Click on the MIDI tab.**
3. **Click on the Double-Clicking a MIDI Clip Opens menu to reveal a list of options.** This list will enable you to choose Pro Tools’ behavior when a MIDI clip is double-clicked.
4. **Choose MIDI Editor.** Double-clicked clips will appear in the MIDI Editor window.
Getting Around the MIDI Editor

Regardless of whether you’re using the Edit window’s docked MIDI Editor or the standalone MIDI Editor window, the tools and layout are the same.

On the left side of the MIDI Editor, you’ll see a familiar-looking Tracks list, which will enable you to not only show and hide tracks (by clicking on the dot to the left of the desired track name) but also to select tracks (by clicking on the track name). In the image shown here, all tracks except the Drums track are being shown, but the Drums track is the only track on this list that is selected. The MIDI Editor’s Tracks list will show you the session’s MIDI, Instrument, and Aux tracks. This enables you not only to view and control MIDI data on MIDI and Instrument tracks, but also to control virtual instrument automation on Instrument and Aux tracks.

In this example, four tracks are shown (if you’re following along with the tutorial session, these are all Instrument tracks). Here, you see one of the key advantages of the MIDI Editor: The MIDI notes of all the shown tracks are displayed in a single environment as opposed to being separated into track rows as they are in the normal Edit window. This enables you to work quickly and efficiently and to clearly see the relationships between multiple tracks.

In a situation like this, when you’re viewing multiple tracks in a single environment, you might be wondering exactly which track you’re working on. No problem—the pencil icon to the right of the track name indicates the track(s) that are the target of your editing.
APPENDIX C More MIDI Power

By default, MIDI notes shown in the MIDI Editor will follow the color of the clip they’re in, which commonly means you’ll see a number of tracks’ MIDI data all in the same color. You can make your editing easier by clicking on the Color Code MIDI Notes by Track button, which will automatically assign a unique color for each track’s notes.

You can also color-code MIDI notes by their velocity values by clicking on the Color Code MIDI Notes by Velocity button. All notes, regardless of their track, will be shown with a red color, with darker colors indicating greater velocity values.

EDITING MULTIPLE TRACKS

You can easily edit multiple tracks simultaneously by placing pencil icons to the right of multiple tracks. Hold down the Shift key as you click on additional tracks to enable editing on a range of tracks. Hold down the Command key (Mac) or the Ctrl key (PC) to enable editing on multiple tracks on a track-by-track basis.

The top of the MIDI Editor features familiar-looking elements—things such as edit modes, editing tools, nudge and grid values, and so on. I covered most of these in Chapters 5 and 6, but there are a few things that bear mentioning before you move on:

You can choose which track you’re editing by clicking on the track name and choosing the desired track from the list that appears. This will move the pencil icon in the Tracks list and changes the focus of your editing.

As with the Edit window, you can choose the default duration and velocity for notes entered using the Pencil tool.

If you want to hear your MIDI data as you’re editing it, make sure the Play MIDI Notes When Editing indicator is illuminated. If it’s not, just click on it, and you’re all set!
If you click on the small triangle icon in the lower-left corner of the playlist area, you’ll reveal the tracks’ automation lanes just as you’ve experienced in the Edit window (which you learned about in Chapter 9, “Finishing Touches”). In the MIDI Editor, however, you’ll be viewing automation lanes for all the visible tracks for a given automation type.

Editing notes in the MIDI Editor is largely identical to the editing workflows covered earlier in this appendix, although in the context of the MIDI Editor, they take on a new level of usefulness. A couple of techniques come in particularly handy when editing notes:

- Double-clicking on a note will delete it.
- If you’re using the Grabber, Pencil, or Smart tool, you can adjust the velocity of a note by holding down the Command key (Mac) or the Ctrl key (PC) as you click and drag vertically.

Perhaps the most engaging feature of the MIDI Editor is the ability to view your music as traditional notation. Just click on the Notation Display Enable button, and your MIDI will be shown as traditional notes on a staff.
You’ll note that your MIDI Editor stays essentially the same (whether you’re dealing with the docked MIDI Editor or the MIDI Editor window), but the format of your MIDI notes has changed. This view is especially useful when you want to tweak your MIDI data while looking at it in a way that makes rhythmic and harmonic structure a bit easier to determine (for those who read traditional notation). Bear in mind that you will still be able to view MIDI velocity and automation data via the track lanes.

Although this is an excellent environment for editing MIDI, it’s not ideally suited to the creation of printable music parts. That’s what the Score Editor window is for, and it’s what you’ll look at next!

**The Score Editor Window**

Suppose you’ve composed a great piece in Pro Tools, but what it really needs is a live musician’s touch. You’ll probably want to create some sheet music for the musician to play, and the Score Editor window is designed to help you do just that. Although this window shouldn’t be confused with comprehensive notation software—it lacks certain layout and notational options that are commonly found in dedicated notation software like Finale and Sibelius—it has what you need to get the job done quickly and easily.

**Getting Around the Score Editor Window**

Using the Score Editor window begins with learning how to display it!

1. **Click** on the **Window menu**.

2. **Choose Score Editor**. The Score Editor window will appear.
The Score Editor window, like the MIDI Editor window, has a look and feel that is consistent with the main Edit window. In the case of the Score Editor window, however, the editing environment is even simpler and easier to use. By showing and hiding tracks in the Tracks list (this Tracks list will only include MIDI and Instrument tracks), you can show a single part or your song’s entire score.

Score and Track Layout

Although note editing can be done in the Score Editor window (something I’ll touch on before the end of this appendix), the majority of your work here will involve the layout of your score and parts. Let’s start by formatting the overall score:

1. Click on the File menu.
2. Choose Score Setup. The Score Setup dialog box will appear.

Here are some other ways to reveal the Score Setup dialog box:
The Score Setup dialog box is the place to go for global control over the appearance of your score. Here’s what you can do:

- Click on the Tracks List button and choose Score Setup from the pop-up menu that appears.
- Double-click on the score’s title.
- Right-click any blank area of the score and choose Score Setup from the menu that appears.

In the Information section, you can type a title and composer for your song.

The Display section will enable you to show or hide basic elements of your music. It’s worth noting that you can show or hide chord symbols (the alphanumeric description of chords, such as CM7) independently from chord diagrams.

The Spacing section will enable you to enter values for the distance between various elements. Alternatively, you can click in a value field and drag your mouse vertically.

- Last but not least, in the Layout section, you can choose your paper size, orientation (portrait or landscape), staff size, and margins.

ON CHANGING STAFF SIZES...
When creating regular lead sheets, the default size is usually fine, but larger staff sizes can be excellent for music education worksheets!
Now that you have the overall layout squared away, let’s take a look at how to tweak individual parts with the Notation Display Track Settings dialog box. You can open this dialog box in a number of different ways:

- Click on the Tracks List button and choose Notation Display Track Settings from the pop-up menu that appears.
- Double-click on any staff’s clef symbol.
- Right-click in any blank area of the score and choose Notation Display Track Settings from the menu that appears.

The important thing to bear in mind when working with the Notation Display Track Settings dialog box is that any changes you make here will affect the track’s visual display only. It won’t change the way your track sounds.

The first thing to do is to choose the track that you want to set up. Just click on the Track menu to reveal a list of all MIDI and Instrument tracks in your session and choose the desired track from the list.
By default, tracks are created with a grand staff, which is the pairing of a treble-clef staff and a bass-clef staff. Although this works well in some situations (such as piano tracks, for example), it’s not a good fit for other instruments (such as the Bass track shown here). You can choose the best clef for a track by clicking on the Clef menu button to reveal a list of options (including Grand Staff, Treble Clef, Bass Clef, Alto Clef, and Tenor Clef). In this example, I’ve chosen to use the bass clef on my Bass track.

The notion of display transposition can be tricky, and only applies to certain instruments. When we say that an instrument is “in the key of C,” we mean that all notes are played at the pitch on which they are displayed on the staff. Although it may sound strange to say it, not all instruments are like that! A trumpet, for example, is a B-flat instrument, and the pitches that a trumpeter plays are one step away from where they are written! This can get quite confusing, but the issue of transposing instruments arises frequently in the world of composing and arranging. The Display Transposition settings enable you to set a track’s transposition. Remember, this will affect the visual display of the pitches only, not the original sound of the track.

The bottom half of the Notation Display Track Settings dialog box deals with an assortment of general display preferences. You’ll see that there are two tabs in this section: Attributes and Globals. The Globals tab enables you to set track defaults and includes several important settings:
Display quantization is a way for you to clean up the look of your parts. Although the written music’s position and duration won’t be exactly accurate in relation to the original MIDI data, the right quantization value can make the part much more readable for a musician. Again, your quantization here is only visual; it won’t alter the sound of the track.

When music is “swung,” 1/8 notes are played back with a degree of a triplet feel. If you have a swingin’ MIDI part, swung 1/8 notes may therefore be visually represented as triplets, which can look a bit strange to the musician. If you check the Straighten Swing checkbox, swung 1/8 notes will be represented as regular 1/8 notes, which is in line with what your musician would expect to see in this situation.

Many instruments—for example, the saxophone—are monophonic by nature and will play only one pitch at a time. For instruments like this, the Allow Note Overlap checkbox should remain unchecked. For polyphonic instruments (such as piano or guitar), you will very often want to check this checkbox.

A split point is the point on a grand staff at which notes will be placed on either staff. (Pitches at or above the split point will be placed in the treble-clef staff, and notes below the split point will be placed in the bass-clef staff.) If you click on the Automatic option button, Pro Tools will determine the split point based on the music on the track. You can, however, specify a fixed split point by clicking on the Fixed option button and typing a value in the field to the button’s right.
Properly setting your Globals attributes is a good way to get your song in shape quickly, but you might run into a situation where you want to set up different attributes for a specific track. That’s when you’ll want to use the Attributes tab. Just click on the Attributes tab and then uncheck the Follow Globals checkbox. Once the box is unchecked, you’ll be able to set distinct settings for that specific track.

Editing in the Score Editor Window

Given the massive power of the MIDI Editor (in either Piano Roll or Notation view), you might find yourself not doing too much editing in the Score Editor window. When you do need to change a note, however, you’ll find that the basic edit tools (Trim, Selector, and Grabber) do just what you would expect them to do. There are a couple of additional techniques worth pointing out, though:

As you might expect, the Pencil tool is great for creating notes. Just click at the desired location on the staff, and a note will appear at the default note duration and velocity. If you want to make the note longer in duration, then just hold down your mouse as you create a note and drag your mouse to the right.

If you want to add a key signature, meter change, or chord symbol, you can do it easily.
Right-click on the position at which you want to insert your key, meter, or chord change. A menu (shown here) will appear.

2 Choose Insert.

3 Choose the type of item that you want to create. The appropriate dialog box (Key Change, Meter Change, or Chord Change) will appear, enabling you to set your values. In this example, I’ve chosen to insert a chord symbol.

4 When you’re finished setting your values, click on the OK button, and your change will be applied.

**SCORES AND RULERS**

Any key, meter, or chord changes you apply in the Score Editor window will be reflected on the appropriate ruler in the main Edit window of Pro Tools.

Printing Your Music

When you’ve gotten your music looking great in the Score Editor window, you’ll want to print your parts. It’s very straightforward and similar to the print process in many other applications.
After you’ve chosen your settings, click on the Print button. Your part will be printed.

Working with Sibelius
For those of you who don’t know the name Sibelius (other than the fact that Jean Sibelius was a famous Finnish composer), it’s one of the leading notation programs on the market these days. Sibelius is not only powerful and flexible, but it’s also fast, which is making it an increasingly popular choice for musicians of all kinds.
If the Score Editor window is open, Pro Tools can export MIDI data as a Sibelius (SIB) file, enabling you to move your MIDI data from the Pro Tools production environment to a more full-featured notation software environment. It’s easy.

1. Display only the part(s) you want to export.
2. Click on the File menu.
3. Choose the Export menu item.
4. Choose Sibelius. The familiar-looking Save dialog box will appear, enabling you to choose a name and location for your new SIB file.

There’s an easier way to get quickly into the Sibelius environment (assuming you have Sibelius installed on your computer). By using the Send to Sibelius feature, you skip the steps of saving your Sibelius file.

1. Display only the part(s) you want to send to Sibelius.
2. Right-click in any blank area of the score. A menu will appear.
3. Choose Send to Sibelius. The Sibelius application will be launched, and your displayed tracks will be exported to Sibelius, where you can work on them further.